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Announcements and General Info

This chapter contains the following topics:

CSP Features by Release
See which CSP features were introduced in which release.

Changes in the CSP Documentation
See what has changed in the CSP documentation since the previous release.



CSP Features by Release
The following table gives an overview of the Coupa Supplier Portal (CSP) features introduced in various Coupa
releases.

Release Feature Description

Release
29

Supplier Onboarding with Additional Profile
Information

The supplier onboarding flow includes additional details.

New Remit-To Experience for Suppliers You are guided through the process of providing remit-to
information.

Other CSP Enhancements You can view tables with invoice lines and SFTP errors,
you can see a reCAPTCHA before merging requests, and
are notified when you are deactivated or reactivated and
if you have too many active login sessions.
The following new notification preference settings are
available: Digital Check Canceled, Virtual Card Canceled,
and Receipt created.
When you decline to respond to supplier
information requests, you need to provide a comment.
Depending on your customers' settings, you can see
payment agreements on POs.

New Payments Page for Suppliers The new Payments page shows a summary of overdue
payments, early payment discount requests, tasks, and
payment preferences to help you collect and reconcile
your receivables from your customers that use Coupa
Pay.

Release
28

Smart Onboarding of Suppliers in the CSP When you register or log in to the CSP to do business
with a customer that uses an onboarding flow, you can
see a welcome message and are guided through the
process of providing the customer with the necessary
information.

Supplier Business Performance You can view a summary of orders and invoices that may
need attention, your year-to-date order and invoice
trends, and your lead time to shipping goods.

Updated CSP Customer Profile Sync You can use an external supplier update (system) form to
update your profiles for your non-SIM customers.

View Public Sourcing Events in the CSP You can access and participate in public sourcing events.

Other CSP Enhancements You can see dispute reasons in the table of invoices and
are notified of PO cancelations and PO acknowledgement
requests.

Release
27

CSP Profile Data Reuse You can reuse your CSP public profile information in
Supplier Information Management (SIM) and email your
non-SIM customers for help to update your customer
profiles.
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Release Feature Description

One-Click Savings You can benefit from savings opportunities provided by
other suppliers through the Coupa Advantage program.

Other CSP Enhancements Public and customer-specific profiles are more clearly
differentiated, and customer-specific profile pages include
information about which customers do not allow profile
changes by default. Also, users are arranged in
alphabetical order and the user permissions are
enhanced to provide targeted access to orders and
service/time sheets.

Release
26

Enhancements to the CSP Home and Profile
Pages

The CSP has additional fields for the public profile and
displays a profile summary.

Restricted Access to Orders and Service/
Time Sheets in the CSP

As a supplier administrator, you can decide which
supplier users can access POs, PO changes, and
service/time sheets.

Improved Emails to Suppliers Some frequent emails from your customers have a new
look and feel and enhanced content.

Enhancements to Collecting Remit-To
Information in the CSP
Supplier Remit-To Redesign

You can provide more remit-to types and add this
information to your legal entities in the CSP so that your
customers can use different payment methods when
working with you.

Release
25

Announcements to Suppliers in the CSP Your customers can create custom announcements to be
shown to you in the CSP.

cXML Error Notifications to Suppliers If you use cXML, you can receive notifications of and view
cXML submission errors.

Enhancements to the CSP Home and Profile
Pages

The CSP displays profile completeness allowing you to
see at a glance if you need to provide more details in your
profiles. Also, if your customers use Supplier Information
Management (SIM), the information you submit through
SIM forms can be reused in your public profiles in
the CSP without having to enter the same information
twice.

Improved PO Emails to Suppliers PO emails you receive have a new look and feel,
enhanced content, and the improved ability to create a
CSP account from emails.

Supplier Support Chat Whether logged in to the CSP or not, you can get help
from Coupa Support also through chat.

Early Payment Discount Term Segments Your customers can assign specific Coupa
Accelerate payment terms to you. You can accept
customer-specific payment terms and choose to apply
them globally.
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Release Feature Description

Release
24

SFTP Account for Suppliers You can create and manage SFTP accounts for your
CSP instances.

Digital Check Payment in the CSP If your customers use Coupa Pay, you can accept
payment through digital checks that you can download
and print from the CSP.

Release
23

Supplier Add-ons An add-on is a value-creating product or service that you
can begin to use or express interest in using, for
example, Coupa Advantage, Coupa Accelerate, or
invoice financing. As an admin, you can access all these
add-ons from one page in the CSP.

Invoice Creation and Other Improvements You can create invoices and enter payment information
more easily due to a more intuitive user interface, and
can enjoy a better user experience.

Release
22

Supplier Notifications for Increased
Accelerate Adoption

You are notified when your customers enable Coupa
Static Discounting and they are ready to accept early
payment discount offers, and you can act quickly on
orders that can be accelerated.

Bulk Export Legal Invoices You can bulk export all the legal invoice
attachments in a .zip file.

Create CSP Accounts from PO Emails and
Forward Invites

You can create CSP accounts by clicking on a button in a
purchase order (PO) email.

Release
20

CSP Two-Factor Authentication with SMS You can use SMS messaging to validate your credentials
when prompted by two-factor authentication.

Early Payment Discount Terms at
Transaction Level

You can choose the type of early payment discount you
want for each purchase order you receive and each
invoice you send. If your choice matches one of the
discount terms on your Coupa customer side, that
discount is automatically assigned to the transaction.

Release
18

CSP Service (Time) Sheets You can manage service/time sheets in the CSP.

CSP User Experience Improvements The Coupa Supplier Portal (CSP), formerly the Coupa
Supplier Network (CSN), upgraded its graphical user
interface (GUI) to optimize better for mobile devices.

Customer-Enforced Two-Factor
Authentication in CSP

Two-factor authentication can be mandatory.

Global Early Payment Discount Terms in
CSP

You can set preferred accelerated payment terms (early
payment discounts terms) in the CSP.

Purchase Order Lines in CSP You can view purchase order (PO) lines with Advance
Ship Notice (ASN) "shipping status" information from the
CSP.
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Release Feature Description

Release
17

Automatic Navigation to Supplier Profile
Update

You are taken from a Supplier Information
Management (SIM) email to update your profile directly in
the CSP.

Public Profile Notifications Turned Off Public Profile Update notifications are turned off by
default.

Recently Used Remit-To Address A recently used remit-to address is the first on the list of
remit-to addresses.

SMS Notifications from Coupa Supplier Portal You can receive notifications in a text message (SMS).

For more information, see Changes in the CSP Documentation.
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Changes in the CSP Documentation

Changes for the January 2021 Release
Topic Change Details

View Business Performance Data Updated The layout of the customers list and the
order/invoice summary dashboards has
changed.

View and Manage Remit-to Information Updated Changed title from View Remit-to Information.
Updated to reflect the changes to the Remit-
To page and to adding remit-to accounts.

Set up Legal Entities Updated Added information about pre-populating the
remit-to fields on SIM form responses.
Updated to reflect the changes to providing
remit-to information.

Create or Update Your Profiles Updated Updated to show the new option of applying
selected payment terms to all the customers
and the new pages in the onboarding flow.
Also, updated to reflect the removal of the
Diversity Certificates field from the Profile
edit page.

Manage Merge Requests Updated Replaced the screenshot of the Admin /
Merge Requests page to show the
disclaimer and the reCAPTCHA.

View and Manage Notifications Updated Added notification preference setting options
for canceled digital checks, virtual cards, and
created receipts.

Manage Users Updated Added information about reactivating users.

Admin Page Updated Added information about viewing SFTP file
upload errors.

Log in to the CSP Updated Added information about multiple sessions
and user deactivation.

View and Manage Payments New Provided instructions on how to view and
manage payment-related information.

View SFTP File Upload Errors New Provided instructions on how to view SFTP
file upload errors.

View Invoice Lines New Provided instructions on how to view invoice
lines.
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Changes for the September 2020 Release
Topic Change Details

Create SFTP Accounts Updated Added a note about required SFTP clients.

Create Custom Views Updated Added information about how to delete a
custom view.

Create or Update Your Profiles Updated Updated with information about how to reuse
public profile information in customer-specific
profiles.
Added information about how to update your
customer profile through an onboarding flow.

Set up Legal Entities Updated Added a tip about the tooltips showing the
number and type of characters allowed in the
banking information fields depending on the
selected bank account country.

Access Add-ons Updated Updated to reflect the changes on the One-
Click Savings and Express Interest pages.

Create or Edit an Invoice Updated Replaced the screenshot of the Invoices
page to show the addition of the Dispute
Reason column to the Invoices table.

View and Manage Invoices Updated Updated to show the addition of the Dispute
Reason column to the Invoices table.

Log in to the CSP Updated Removed the warning and note about the
banner listing permissions.
Updated with information about the new login
page with the welcome message.

Create Your Account Updated Added a note about the case when you join
the CSP from one of two simultaneous
invitations.
Added Proposal Manager to the list of
available roles within the Sales department.
Updated with information about the new
registration page with the welcome message.

Manage Users Updated Updated to show that the Admin main menu
item has moved under the new Setup main
menu item.
Replaced the screenshots to show the new
Business Performance and Sourcing tabs
and the Business Performance and
Sourcing permissions necessary to see
them. Also, updated the table with the new
permissions.
Added more details about how to use
the Restricted Access to Orders and
Restricted Access to Service/Time Sheets
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Topic Change Details

permissions.

View and Manage Notifications Updated Added notification preference setting options
for canceled orders, granted permission for
viewing business performance, and bank
transfer, virtual card, and zero payment
remittance advice.

Navigate and Get Help Updated Updated with information about the Business
Performance menu item.

View Business Performance Data New Provided instructions on how to view a
summary of orders and invoices that may
need attention, year-to-date order and invoice
trends, and lead time to shipping goods.

View Public Sourcing Events New Provided instructions on how to view public
sourcing events.

CSP Videos Updated Added a new video about the customer-
branded welcome message and updated
existing videos.

CSP Features by Release Updated Added information about the features
introduced in this release.

Changes for the May 2020 Release
Topic Change Details

Access Add-ons Updated Updated to reflect the changes in content and
layout and to provide details about the One-
Click Savings add-on.

CSP Videos Updated Added a new video about One-click Savings.

CSP Features by Release Updated Added information about the features
introduced in this release.
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Changes for the January 2020 Release
Topic Change Details

View and Manage Notifications Updated Updated to reflect that the notification
preference setting A new comment is
received for Form Responses is enabled by
default for new suppliers.
Added new notification preference settings.
Also, added information about stopping SMS
notifications by replying STOP.

View and Manage Invoices Updated Added information about the Totals with
Early Payment Discount section on legal
invoices.

View and Manage POs Updated Added information about the tooltip text of the
icon for flipping a PO into an invoice.
Added information about the new Assigned
To column.

View and Manage Service/Time Sheets Updated Added information about the new Assigned
To column.

Register for the CSP Updated Updated the information about the content
and format of email invitations.

Create Your Account Updated Updated to reflect the new Department and
Role fields.

Create or Update Your Profiles Updated Added information about the profile summary,
the Learn More link, and the new fields on
the Public Profile page.

Manage Your Account Updated Updated to reflect the change of the page title
from My Account Password to My Account
Settings, the new Department and Role
fields, and the User Details and Change
Password sections.

Manage Users Updated Added information about the Restricted
Access to Orders, Restricted Access to
Service/Time Sheets, and Pay Me
Now permissions.

Invoices Updated Added information about how long legal
invoices are available for download.

Navigate and Get Help Updated Replaced the screenshot of the Home page
to show the new Profile Summary section
and reflect the other changes to the profile.
Replaced the screenshot of the contact
information pop-up for chatting with Coupa
Support to show the new text stating that the
Coupa Support chat is only for technical
issues with the CSP.
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Topic Change Details

Admin Page Updated Updated to reflect that E-Invoicing
Setup has changed to Legal Entity Setup.

Create or Edit an Invoice Updated Updated to reflect the changes to adding new
or choosing existing invoicing details.
Added information about the tooltip text of the
icon for flipping a PO into an invoice and
about the fields that cannot be edited if
customers mandate PO acceptance.

Set up Legal Entities Updated Changed title from Set up E-Invoicing.
Updated to reflect the changes in setting up
legal entities.
Changed the requirement of 4-28 digits to
4-28 characters for the Account Number
field.
Added details about how to fill in the What is
your Tax ID? section in the absence of a tax
ID number.

CSP Videos Updated Added a new video about the profile
summary and additional fields.

CSP Features by Release New Provided information about which
CSP features were introduced in which
release.

Changes for the September 2019 Release
Topic Change Details

Create an Invoice from a PO, Create a Credit
Note

Removed Moved the content of these topics to Create
or Edit an Invoice.

Create or Edit an Invoice Updated Updated with content from topics Create an
Invoice from a PO and Create a Credit Note,
and added instructions on how to create a
blank invoice and an invoice from a contract.

CSP Videos Updated Updated the videos for Intro, Help, Profile,
Orders, Invoices, Catalogs, and Admin. Also,
added new videos about profile
progress, announcements, and creating
invoices.

Register for the CSP Updated Updated the information about registering to
the CSP from a PO email.
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Topic Change Details

Set up E-Invoicing Updated Added information about the Account
Number field digit count limit being
increased.

Navigate and Get Help Updated Provided instructions on how to chat with
Coupa Support to get help. Also, replaced the
screenshot of the Home page to show the
sections for profile progress and
announcements.

Create or Edit an Invoice Updated Added information about the possibility to
update PO references on invoice lines
and add PO lines from other orders.

Manage Users Updated Added information about the Order Changes
permission.

View and Manage Notifications Updated Added notification preference setting options
for customer announcements, integration
errors, rejected PO change requests, and
Coupa Pay new virtual cards, reissued virtual
cards, and virtual card reminders.
Also, updated to reflect the new
Announcements filter option on the My
Notifications page.

Create or Update Your Profiles Updated Added information about the profile progress
indicator and the new fields on the Public
Profile page.

View and Manage Invoices Updated Replaced the screenshot of the Invoices
page to show the position of the buttons for
creating invoices or credit notes.

View and Manage POs, View PO Lines Updated Replaced the screenshot of the Orders page
to show the Order Changes and Order Line
Changes tabs.

Admin Page Updated Added information about viewing cXML
submission errors.

Manage Merge Requests Updated Replaced the screenshot of the Admin
Merge Requests page to show all the tabs
on the page.

Set Coupa Accelerate Preferences Updated Updated to reflect the possibility to
select customer-specific payment terms and
apply them globally.

Create Custom Views Updated Added information about the new pages that
have tables.

Edit a PO New Provided instructions on how to request
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Topic Change Details

changes to POs and add shipment tracking
information.

View Customer Announcements New Provided instructions on how to view
announcements from customers.

View cXML Submission Errors New Provided instructions on how to manage
notifications of and view cXML errors.

Changes for the May 2019 Release
Topic Change Details

Set Coupa Accelerate Preferences Updated Removed notes informing users that after
logging in they need to navigate to pages that
they tried to access from URLs without being
logged in initially. Users that click on links to
CSP pages without being logged in are now
directed to the relevant pages (not to the
Home page) after logging in.

Set up E-Invoicing Updated Added information about the Account
Number field digit count limit being increased
from 17 to 19.

Manage Users Updated Replaced the screenshots to show the new
Payments tab and the Payments permission
necessary to see it. Also, updated the table
with the new permission.

Admin Page Updated Added information about creating SFTP
accounts.

View Service/Time Sheet Lines Updated Updated to reflect the changes in layout and
information provided on service/time sheet
lines to support partial acceptance of
services.

View and Manage POs Updated Added a tip about adding comments to POs
that suppliers do not accept and want to
reject.

View and Manage Notifications Updated Added notification preference setting options
for abandoned invoices and Coupa Pay new
digital checks.
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Topic Change Details

View and Manage Invoices Updated Added information about the new Abandoned
invoice status.

Create or Edit an Invoice Updated Added information about invoices associated
with digital checks and bank transfers being
populated with payment information.

Navigate and Get Help Updated Replaced the screenshot and updated the
table to show the new Payments tab.

Log in to the CSP Updated Updated the Additional Features page of
the Welcome tour with information about the
new Payments page.

View and Download Digital Checks New Provided instructions on how to view and
download digital checks.

Create SFTP Accounts New Provided instructions on how to create and
manage SFTP accounts.

Changes for the January 2019 Release
Topic Change Details

View Remit-to Information Updated Updated to show that new remit-to addresses
can be created/added directly when creating
invoices.

Set up E-Invoicing Updated Updated to reflect the changes in setting up
legal entities.

Create a Credit Note Updated Updated to reflect the changes on the Create
Invoices page.

Create or Edit an Invoice Updated Updated to reflect the changes on the Create
Invoices page and in how an invoice is
created from a contract.

Create an Invoice from a PO Updated Updated to show that new remit-to addresses
can be created/added directly when creating
invoices.

Create or Edit a Service/Time Sheet Updated Updated with information on service/time
sheet lines.

View PO Lines Updated Added information on new PO line fields for
services.
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Topic Change Details

View and Manage Service/Time Sheets Updated Replaced the screenshot to show the new
Service/Time Sheet Lines subtab.

Navigate and Get Help Updated Replaced the screenshot of the Help
Tour with a reference to the section on the
updated welcome tour.
Replaced the screenshot and updated the
table to show the new Add-ons tab.

Create or Update Your Profiles Updated Added a note stating that changing the
customer-specific profile might update the
supplier information that the specific
customer has on record.

Log in to the CSP Updated Added information on the new welcome tour.

Register for the CSP Updated Updated with information on the changed
subject line, content, format, and style of the
email invitations.

View Service/Time Sheet Lines New Provided information on viewing service/time
sheets at line level.

Access Add-ons New Provided information on the add-ons that
admins can access.

Changes for the September 2018 Release
Topic Change Details

Register for the CSP Updated Updated with information on additional
options to register for the CSP.

Create Your Account Updated Updated with information on forwarding your
invitation to the CSP.

Log in to the CSP Updated Added information on the banners that warn
about permissions.

View and Manage Notifications Updated Added notification preference setting options
for form response reminders, early payment
opportunities, and legal invoice export results.

View and Manage Invoices Updated Added information about downloading all the
legal invoice attachments in one compressed
file.

Set Coupa Accelerate Preferences Updated Updated with instructions on how to
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Topic Change Details

accelerate orders from PO emails and
information on notifications of customers who
are ready to accept early payment discount
offers.

CSP FAQ / Invoices Updated Added a note to the Why can't I edit, void, or
delete an invoice? frequently asked question.
Updated the What does the Export to button
do? frequently asked question with
information on bulk exporting legal invoices
and increased export size limitation.

Changes for the May 2018 Release
Topic Change Details

CSP FAQ / Other Updated Added a frequently asked question about
archiving information in the CSP.

Register for the CSP, Create Your Account,
and Log in to the CSP

Updated Replaced the screenshot of the Register/Log
In page to show the newly added links where
you can get help with registering and logging
in.

Create or Edit an Invoice Updated Added information on the warning message
that you might get if you try to submit an
invoice that does not meet your customer's
requirements.

View and Manage Notifications Updated Added two new notification preference setting
options.

Manage Users Updated Replaced the screenshot of the Edit user
access for [User Name] window to show
that the Deactivate User button is inactive for
the user who is logged in. Also, added a note
to explain the reason.

Changes for the January 2018 Release
Topic Change Details

Create or Edit an Invoice Updated Added a note stating that it is not possible to
pick lines from POs when creating an invoice.
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Topic Change Details

Enable or Disable Two-Factor
Authentication and Log in to the CSP

Updated Updated with instructions on how to use SMS
messaging to validate your credentials when
prompted by two-factor authentication.

View and Manage Notifications Updated Updated with information on new notification
preferences that you can set to get notified if
your customer sends you a comment or
replies to your question/comment about
unclear sections of the SIM update request
form or provides a reason for rejection.

Set Coupa Accelerate Preferences Updated Updated with instructions on how to set early
payment discount terms at transaction level,
that is, for specific orders and invoices for
some or all customers.

View and Manage Invoices Updated Updated with information on resolving
disputed invoices.

Create a Credit Note New Provided instructions on when and how to
create a credit note.
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Get Started with the CSP

This chapter contains the following topics:

Register for the CSP
Self-register at supplier.coupahost.com, get an invitation email from your Coupa customer, forward an invitation to a peer,
or create an account from a PO email.

Create Your Account
After receiving an invitation, create your CSP account.

Log in to the CSP
See how to log into the CSP using single or two-factor authentication.

Create Custom Views
Change the view settings depending on how you want to see information on orders, invoices, catalogs,
service/time sheets, ASNs, or payments for each customer.

Create or Update Your Profiles
Update your public and customer-specific company profiles.

Enable or Disable Two-Factor Authentication
Enable two-factor authentication for additional security.

Manage Your Account
Change your personal information, set your notification preferences, or enable/disable two-factor authentication.

Navigate and Get Help
Learn where to find what in the CSP, including help.

View and Manage Notifications
View your notifications and set your notification preferences.



Register for the CSP
You have the following options to register for the CSP:

Method Benefits Considerations

Customer-created
invitation

You get a custom-invitation with specific
instructions and a proactive message from
your customer.
When you accept the invitation and create
your account, you are automatically
connected/linked to the customer who invited
you.

You have to wait for your customer to send
the invitation email. This means that you
might not get invited due to your customer
forgetting or not having the time to send the
invitations to all their suppliers.

Self-created invitation You can set up your accounts ahead of time,
add multiple users, set up your login
preferences, and update your profile more
quickly.

You need to connect manually to your
customers in Coupa. Let your customer know
that you registered and you want to connect
with them.
Customers can connect with you through
their Supplier Portal Directory, or by sending
an invitation email to any of the CSP supplier
users on the account. However, if you are
invited using a different email, that email can
log in but will have to merge with the account
that was set up ahead of time in order for all
the supplier users to be on the same account
and linked to the customer.

Purchase order (PO)
email

Your customer does not have to proactively
manage invitations and reminders for you to
get connected through the CSP.
You can create a CSP account without
requiring an invitation if you use Supplier
Actionable Notifications (SAN),
InvoiceSmash, or other PO methods.
As PO emails are a frequent communication
channel between you and your customers,
you have more opportunities to create a CSP
account and enjoy its benefits.

None

Forwarded invitation
from a coworker

You can easily invite others within your
organization to the CSP by forwarding them
your PO email notification or by sending them
an invitation from the create account page.
You end up with the right supplier user(s)
linked to and transacting electronically
through the CSP with less work.

You can forward the invitation only to email
addresses with the same domain. However,
this ensures more built-in security.

With all methods, you need access to the email address you are going to use for the account.

Your CSP account is based on a specific email address. If you use an email address different from the one your Coupa
customers have on file for you, you cannot connect with them until you give them the email address or create a
CSP account with that email address.
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Customer-created invitation
Ask your customer to send you an invitation to the CSP.

Self-created invitation
Go to supplier.coupahost.com and in the Register pane on the left, fill in the mandatory (email) field (marked with an
asterisk), and then click Register to request an invitation.

In both cases, you receive an email invitation with a different subject line, depending on whether the invitation was sent
by your customer or was initiated by you.

If the email was initiated by your customer, it contains the customer logo instead of the Coupa logo.

Tip: If you do not receive your invitation email, check your spam folder.

The email contains instructions and links to useful information, and buttons for joining the CSP or forwarding the
invitation. Depending on your customers' settings, your invitation emails might look different and have different sections.
For example, if your customer enabled new email formats, your email has the following sections:

Section Description

Top section Section specific to the type of the email. Depending on the type of email, it also
contains relevant buttons, for example, to register for the CSP.

More about the CSP /
Do More with the CSP /
Get Connected with the CSP

Provides basic information about the CSP, its benefits, and a link to Learn more
about Coupa for Suppliers or Get Started with the CSP.
Depending on the type of email, it also includes instructions.

What is Coupa? Provides a short introduction to Coupa and a link to Find out
more about Coupa for Suppliers.

Note: For the new email format, only Microsoft Outlook version 16 is supported.
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Forwarded invitation
You can invite others to the CSP by forwarding them your PO email notification with the Create Account button, by
clicking on the Forward This button in your CSP invitation email, or by sending them an invitation from the create
account page.

Warning: You can forward the invitation only to email addresses with the same domain.

An invitation to the CSP is sent to the email address that you specified.

When the invited user clicks on the Join Coupa button in the email, the user is directed to create an account to
the CSP.

If the user is already linked to the CSP or tries to create an account from an expired invitation, the user is directed to the
Register / Login page where a red message bar displays the following: "Your invitation has expired or already been
activated."

Warning: Invitations to the CSP expire after 30 days.
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Create Your Account
Join the CSP
After following the link from an invitation email (other than customer-created invitation), fill in the mandatory fields to
provide basic information for your account and your company's public profile.

Setting Description

*First Name Your personal first name to be applied to your personal account.

CSP Admin and User Guide Get Started with the CSP

Valid until January 31, 2021 25



Setting Description

*Last Name Your personal last name to be applied to your personal account.

*Company The name of your company as seen on your company's public profile.

*Department The name of your department: Sales, Operations, Accounts
Receivable, Treasury, or Other.

*Role Your role within the department:

• Sales: Sales Manager, Sales Associate, Proposal Manager, Other
• Operations: E-Commerce Manager, Order Fulfillment/Inventory

Management, Other
• Accounts Receivable: Accounting Manager, Accounts Receivable Associate,

Other
• Treasury: Treasury Manager, Other
• Other: Enter free text.

Tip: If you select Other for Department and/or Role, the User Specified
Department and/or User Specified Role fields are displayed for you to
enter free text.

*Email This field cannot be changed. If you want to change your email address, you have
to create a different CSP account using the new email address. If you also want
to use this email, create two company accounts and merge them. For more
information, see Manage Merge Requests.

*Password Use this field to create your password. It must be at least 8 characters long, and it
has to include a number and a letter.

*Password Confirmation This field needs to match the password you typed in the password field.

Note: If you join the CSP from one of two simultaneous invitations received from your administrator and your
customer, you might see a green box with a question asking whether you are an employee of the supplier
organization and you need to select either the Yes – Join or No – Create New Account checkbox.

Welcome message

Note: You can see this feature only if your customer(s) enabled it.

When you join the CSP from a customer-created invitation, you can see a registration page that is different from the
page shown above. The Create your business account page contains the following welcome message and company
logo by default. Your customer can customize the welcome message and add their logo, so the message might be
different from the one shown below.
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You need to enter your email address and password, and accept the Privacy Policy and the Terms of Use. You can get
help to sign up or you can forward the invitation to others by clicking on the relevant links.

Tip: You can update your information later on the My Account Settings page. For more information, see
Manage Your Account.

By default, this account is the admin account for your company. Once set up, you can add users and assign them roles,
including account administration. For more information, see Administer the CSP.

Forward your invitation
You can invite others any time by entering their email address in the Forward email field in the Forward your
invitation section and clicking Submit, or by clicking on the Forward this to someone link if you see the welcome
message.

For more information, see Register for the CSP.
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Log in to the CSP
Login page
Go to supplier.coupahost.com and in the Log In pane on the right, enter your email address and password and click
Log In.

Multiple active sessions
You cannot have more than three active sessions simultaneously. When you log in to another session, you are forced to
close an open one. A message notifies you that you have too many active logins and you will be signed out from one of
your other sessions if you click Log In. You can also Cancel the attempt to log in to another session.

Inactivity
Your account is deactivated automatically if it is inactive for a defined period of time, that is, if:

• You have not logged in to the CSP for more than 90 days.

• You have not verified your account for 6 months.

When you try to log in as an inactive user, a red message bar notifies you of the verification email you received. To
reactivate your account, you need to confirm that email. On the CSP login page, a green message bar informs you of
the successful email verification and you can log in. For more information, see Log in to the CSP.
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Welcome message
When you log in for the fist time from a new customer-created invitation, you can see the following welcome message
and company logo by default. Your customer can customize the welcome message, so the message might be
different and have your customer's logo instead of the Coupa logo.

Welcome tour
Once you are signed in, Coupa takes you on a welcome tour.

Note: If you log in from a new customer-created invitation, the welcome tour is not shown, but you can
access it from the Help menu. For more information, see Navigate and Get Help.
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You can skip the tour by clicking on the Skip button or closing the window with the X in the top right corner. Clicking
Next takes you to the second page of the tour, which provides you with basic information on the benefits of invoicing
through the CSP.

By clicking on the relevant link, you can go directly to view the Orders, Invoices, or Admin pages, or go to the next tour
page that provides basic information about how the CSP can help you transact and communicate with your customers,
for example, by allowing you to manage your catalogs, orders, and invoices, and setting notification preferences for
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important customer transactions.

The fourth (last) page of the tour summarizes the additional features, for example, the possibility to provide supplier
information through the CSP, update POs with advance ship notice (ASN), update catalog items, and features for
payments, such as, managing payment settings. If you click on the Go to Online Help to Learn More link, you are
directed to the Coupa Supplier Portal Admin and User Guide for details on each feature.

Two-factor authentication
When you log in for the first time, you are prompted to enable two-factor authentication. For more information, see
Enable or Disable Two-Factor Authentication.
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Note: Some customers may require you to use two-factor authentication when accessing their information.

Log in with two-factor authentication
If you have enabled two-factor authentication, the Two-Factor Authentication window opens when you want to log in to
the CSP.

If you enabled the Two-Factor Authenticator App, choose open Google Authenticator on your device, choose your
CSP account, and get the validation code.

If you enabled two-factor authentication for SMS, check your text messages to get the verification code.

Type the two-factor authentication code in the appropriate field, choose Remember this computer for 30 days if you
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are not using a shared or public computer, and click Log In.

Note: The code is good only for 60 seconds. If you do not type that code on the CSP sign-in page and click
Log In within 60 seconds, you have to get a new code and try again.

For more information, see Enable or Disable Two-Factor Authentication.

Note: If you are locked out and you do not have your six-digit backup validation code, contact your customer
who will ask for a declaration form and either your email used to log in to the CSP or a copy of your photo ID
or passport to verify your identity.
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Create Custom Views
You can create custom views for orders, order lines, order changes, order line changes, service/time sheets, service/
time sheet lines, advance ship notices (ASN), invoices, catalogs, invoice payments, and PO payments.

With a custom view you can create a set of advanced search filters.

1. On the main menu, click on the tab for the function for which you want to create a custom view.

2. At the top of the table whose view you want to change, click Create View in the View drop-down list.

3. On the Create New data table view page, select the customer for whom you want to change the view settings,
and then specify the settings you want to use for your custom view, including filtering conditions, columns to
include, and sorting criteria.
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If you want to build this view based on another view and modify those settings, use the Start with view option
under the General settings.
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You can use the following settings when creating or editing a custom view for a CSP table.

Group Setting Description

General Name Name of the custom view, visible from the View drop-down list at the top of
the table.

Visibility Defines whether this view can be visible to only you or all the other users that
can see the main table.

Start with view Use this option to load the settings from another view, and then modify those
settings to fit your needs for this view.

Conditions Apply All - Displays results only for objects that meet all of the conditions you add in
this list.
Any - Displays results for objects that meet at least one of the conditions you
add in this list.

Conditions Create conditions based on the data available in the CSP.

Columns Available
columns

This list depends on the table you work with in the CSP. You can select any
of these columns to add to your custom view.

Selected
columns

These are all the columns displayed in this custom view. They appear from
left to right, in the same order that you set them up here.

Default Sort
Order

Choose the column by which you want results to be sorted and define whether to sort them in
ascending or descending order.

4. Save your settings.

To delete a custom view, open the view for editing by clicking on the Edit View ( ) icon and click on the Delete ( )
button at the bottom of the page.
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Create or Update Your Profiles
In the CSP, you have a public profile and you can have specific profiles for your customers that you are connected with
through the CSP.

You can view and update your public and customer-specific profiles from the Home page or the Profile page.

Tip: When you register or log in to the CSP to do business with a customer that uses an onboarding flow,
you are guided through the process of providing the customer with the necessary information. For more
information, see Update your customer profile.

Note: Some sections are labeled as private and cannot be seen from the CSP. Financial information (for
example, your tax ID, DUNS, and remit-to addresses) are considered private information. This information
appears only on documents that you create through the CSP, for example, on invoices.

Update your public profile
Anyone can find and connect with you through your public profile.

Your public profile is created when you create your account and it contains general information about your company, for
example, name, logo, website, industry, year of establishment, top commodities, currencies, diversity, and corporate
social responsibility rating (on the Home and Profile / Public Profile pages), the link to your public profile (on the Home
page), and contact information (on the Profile / Public Profile page).
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Profile progress
At the top of the Home page, you can see your profile progress/completeness.

The following table shows the profile completeness stages.

Profile Progress Bar Color Message

Red Action needed: Complete your profile to get paid faster and get discovered.

Blue Recommended: Complete your profile to get paid faster and get discovered.

Green Great job! A complete profile helps you get paid faster and get discovered.

Next to the progress bar, the Last Updated field shows how long ago the profile was updated, for example, 2 minutes
ago or 10 days ago.
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The following table shows the color of the progress bar depending on the age of the profile.

Percentage of
Completeness

Last Updated < 1 Year
Ago

Last Updated 1-2 Years
Ago

Last Updated > 2 Years
Ago

< 50% Red Red Red

50% - 80% Blue Blue Red

80% - 100% Green Blue Red

The Learn More link next to the profile progress message opens the Get Discovered with a Complete Public Profile
popup with tips and information on the benefits of a complete public profile.

Clicking Update Profile opens your public profile for editing.

Profile summary
Under the section about your profile progress, you can see an actionable profile summary, which shows the number of
legal entities and registered users based on the information provided in your profile, and the number of connected users,
that is, the number of customers linked to your profile.

Clicking on the View link under Legal Entities takes you to the Admin / Legal Entity Setup page where you can add,
update, or deactivate legal entities.

Clicking on the View link under Registered Users directs you to the Admin / Users page where you can invite new or
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manage existing users.

The profile summary also indicates if you have ( ) or have not ( ) provided banking and diversity information, if you
accelerate orders/invoices, and if you have a bribery policy.

Profile information
To improve your progress by updating your profile, click on the:

• Improve Your Profile button on the Home page next to the section about your profile progress.

• Update Profile button in the Get Discovered with a Complete Public Profile popup.

• Edit Profile button on the Profile page after selecting Public Profile from the drop-down list.
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Fill in the following fields:
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Setting Description

General Information

*Name Your company's name.

Logo Select an image to upload as your company's logo.

Profile Background Select an image to upload as the profile background.

Industry Select your industry from the drop-down list.

Year Established Enter the year when your company was established.

Short Description Add a short description of your company.

Full Description Add a full description of your company.

Registered Users Add registered users by inviting them. For more information, see Manage Users.

Website Enter your company's website.

LinkedIn Profile, Facebook
Profile, Twitter Profile

Enter the relevant link(s) to your company's social media profile(s).

Address

Address Lines 1 and 2, City,
State, Postal Code, Country/
Region

Enter your company's address.

Primary Contact

*First Name, *Last Name, *Email Enter the name and email address of your company's primary contact.

Work Phone, Mobile Phone, Fax
Number

Enter the relevant phone number(s).

PO Delivery Email Enter the email address where you want to receive your customers' purchase
orders.

Business Details

Company Size Select a range from the drop-down list to show the size of your company.
Available options: self-employed, 2-9, 10-49, 50-99, 100-249, 250-499, 500-999,
1000-5000, and 5000+ employees.
This is private information and not published to your public profile.

Top Commodities Select your top five UNSPSC Level 2 (Family) categories from the drop-down.

Bribery and Corruption Policy Select the relevant radio button:

• Yes, we have a policy
• No

Policy for Bribery and Corruption If you selected Yes, type in or copy and paste your policy.
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Diversity Select a country/region along with a diversity type from the drop-down lists to
indicate if your business has a diversity ownership. Available options:

• United States
• Outside of the US
• None

Corporate Social Responsibility
Rating

Select a rating agency if applicable. Available options:

• CSRHub
• MSCI Inc.
• Truvalue Labs
• EcoVadis
• Scope 5
• EnergyStar
• Inoxico (South Africa)
• D&B
• LexisNexis
• Workato
• Ecodesk Horizon
• RBA
• IntegrityNext
• WBCSD's
• GreenSeal
• GFSI
• Other

Financial and Legal Information

Accelerate Indicates if Coupa Static Discounting is enabled or disabled. Click on the Edit
Preferences link to modify your early payment discount preferences. For more
information, see Set Coupa Static Discounting Preferences.

Currencies Select all the currencies that you prefer.

DUNS Number Enter your Data Universal Numbering System (DUNS) number.
This is secure information and is not published to your public profile.

Legal Entity subsection Lists all your existing legal entities allowing you to manage them or add new ones
directly from this page.
If you have three or more legal entities, they are collapsed. To view their details,
click on the Down arrows.
Clicking on the Add Legal Entity button directs you to the Legal Entity Setup
page. For more information, see Set up Legal Entities.

Reuse your customer-specific profile information in your public profile
When you receive a supplier information form request from your customer to create or update your profile, you can copy/
save the provided information to your CSP public profile. After submitting your supplier information for approval, click
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Yes, Copy to Profile in the appearing popup window.

Note: Your existing CSP profile data is overwritten with the data you provided in the supplier
information form only when you save the form.

You are directed to the Public Profile edit page where the following fields are automatically populated (and highlighted
in yellow) based on the provided information: Name, Industry, Full Description, Website, Bribery and Corruption Policy,
Address (all fields), Primary Contact (all fields), PO Delivery Email, and DUNS number. Save your profile to confirm the
updates.

Update and reuse your public profile information in your customer-specific profile
Keep your information accurate and up to date for each of your customers.

Note: Depending on your customers' settings, your customer-specific profile changes may update
the information that your customers have.

To update your customer-specific profiles, go to Profile > Your Customer Profiles. To manage a specific profile, select
the customer name from the Profile drop-down list. If you do not see the customer you are looking for, it means that you
are not connected to them yet. You cannot see them in the Select Customer drop-down list on the Orders, Service/
Time Sheets, ASN, Invoices, Catalogs, and Payments pages either.

If any of your customers uses a supplier information form, and you update information in your CSP public profile, you are
prompted to update your customer profile if you have any supplier information form requests. You can update your
profile also for customers that do not use a supplier information form by requesting help from those customers' supplier
account owners.
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After editing and saving your public profile, you can see a green banner notifying you about your profile update status,
for example: "Your company info was successfully updated on your Public Profile and 2 customer profiles."

Depending on whether your customer profile is for a customer using supplier information forms or not, you can also see
popups with various information and instructions.

Customer profile update with supplier information form
The popups depend on the following scenarios:

• One or multiple supplier information customer profiles that are new/blank (not filled out) or saved (filled out and
saved).

• One or multiple supplier information customer profiles that are filled out and submitted for approval, or approved
and applied.

In the Action Needed: Update Customer Information popup, you are informed if you need to edit a specific form and
provide more information (due to the differences between the public profile fields and the customizable customer
profile fields), or if you can submit the form for approval as is.

Click on the Open button to open your customer profile for editing with fields (highlighted in yellow) pre-populated based
on your public profile.
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Tip: You can see this page also for other customers using supplier information forms if you select them from
the Profile dropdown.

Add the missing information and submit your form for approval.

Note: If you make changes, you are asked if you want to save the new information to your public profile. For
more information, see Reuse your customer-specific profile information in your public profile.

Tip: Click on the Show changes link to see the information that populated the fields before they were
updated with information from your pubic profile.

If you try to submit your form for approval before it is approved, you are informed in a red banner that it is pending
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approval. To update your profile, you need to withdraw the request and resubmit your changes.

Tip: If you close the popup, you can open it any time from your Notifications by clicking on the
Update information requests notification. For more information, see View and Manage Notifications.

Customer profile update without supplier information form
In the Action Needed: Update Customer Information popup, in the yellow banner, you are informed that you
need to contact one or more customers directly to update your customer profiles for them.

Click on the show details link to see the names of customers that you need to contact. Clicking on a name allows you
to email directly to the customer's supplier account owner who can help you with updating your profile.

If you select a customer from the Profile dropdown on Your Customer Profiles page, you can see a yellow banner with
instructions depending on whether your customer provided one, more, or no supplier account owners.

If the customer provided supplier owner contact information, you can email them directly by clicking on the email
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address (one contact email) or on the send them an email link (more email addresses).

Note: If your customer did not provide a supplier owner contact (email), you cannot contact them from this
popup. You need to contact them through the same channel(s) as before.

If your customer does not use a supplier information form, depending on their settings, you might be able to see the Edit
button and edit your customer profile.

Update your customer profile
When you register or log in to the CSP to do business with a customer that uses an onboarding flow, you
are guided through the following elements of the flow to provide your customer with the necessary information:
welcome message, basics, payment, and profile.

Note: Some elements of the onboarding flow, for example, fields for invoicing setup and bank information for
payment, are available only if you are based in the US, that is, your selected country/region is the United
States. If you are not a US-based supplier, only the basics and profile elements, and the payment discount
preferences settings are available.

You can provide this data when setting up legal entities after onboarding.

Welcome message
For more information, see Create Your Account and Log in to the CSP.

Basics
Clicking on the Get Started or Continue button takes you to the Tell us about your business page where you can
provide your basic information.
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Note: Providing your address is required.

Tip: Click on the Info ( ) icon to learn more about the fields.

Fill in the following fields: Company Name (registered company name to be displayed on your invoices), Website,
Country/Region, Address Lines 1-2, City, State, and Postal Code.

Note: Name and address fields are pre-populated if your customer already has the information from you in
their supplier record, or if you are already registered to the CSP to transact with other customers and
provided the information in your profile. You can also choose to update these fields.

Mandatory fields are marked with a red asterisk (*).

If you are not a US-based supplier, at the bottom of the page you are informed that you are All set for now. On your
first invoice with <customer name> , we will guide you through your legal entity setup.
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If you are a US-based supplier, after providing your address, you also have the option to set up a legal entity. You can
Also use this address as: Invoice from location, Pay to location (Remit-To), and/or Ship from location by leaving
the relevant checkbox(es) selected. Or, if you want to provide a different address for invoicing, payment, and/or
shipping, deselect the relevant checkbox(es) and enter the new address.

• Invoice from location is the main address of your registered business or the registered entity you will be invoicing
your customer from.
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• Pay to location is the address your customer will use to send your payment; remittance address.

• Ship from location is usually your warehouse location.

Also, the Advanced Invoicing checkbox allows you to indicate if you support integration for invoicing (cXML or SFTP)
and plan to use it with your customer.

Tip: If you are already registered to the CSP and you set up a legal entity earlier, you can also see the Use
my current legal entity drop-down from which you can select your existing legal entity to provide it to your
new customer.

Payment
Clicking on the Next button takes you to the Provide your default bank information page where you can provide your
payment information.

Note: You can see the page for bank information only if your customer uses Coupa Pay. Providing your
bank information is required.
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Fill in the following Bank Information fields: Country/Region (defaulted), Currency (defaulted), Routing Number,
Account Number, Confirm Account Number, Bank Name, Address Lines 1-2, City, State, and Postal Code. The
address that you entered when providing your basic information is also linked to this payment account.

Mandatory fields are marked with a red asterisk (*).

Indicate if you accept card payment by selecting the checkbox under Card Payment. If you accept card payment,
you need to specify the email address where you want to receive the card.

Tip: If you selected a legal entity that contains US banking information, at the top of the page you can see
the Payment Address section to select the address from the Remit-To drop-down to pre-populate the bank
information fields for your new customer, instead of providing new bank information.

Clicking on the Next button takes you to the Would you like to offer discounts to get paid faster? page where you
can set your Payment Discount Preferences (static discounting, formerly: Coupa Accelerate preferences). These
preferences are automatically applied to all your invoices with the customer.
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Note: Providing your payment discount preferences is optional. The selected payment terms can be used
only with your Coupa Pay customer(s).

On the left you can see your default payment term(s), and on the right, you can select new terms to automatically
replace the existing ones.

If you want to apply the selected payment terms to all your customers, select the Use these preferences for all your
customers checkbox.

Tip: You can modify them later at any time from Setup > Admin > Payment Preferences > Static
Discounting.

Use the Back button to go back to the pages with bank and basic information.

Profile
Clicking on the Next button takes you to the page informing you about your successful setup that allows you to do
business with your customer.
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You are encouraged to update your public profile so that other customers can also find you.

Note: Providing more profile information is optional.

Tip: If you want to provide your profile information later, click the Do it later link to exit the customer setup.

Click on the Enhance Your Coupa Profile button to provide profile information related to your diversity, commodities,
and transactions.

On the Are you a diverse business? page, select a country/region from the dropdown list and select all the diversity
types that apply. Your selections are highlighted.
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Tip: By default, your primary address country is selected. You can provide diversity information for several
countries/regions.

Tip: By default, the six most frequently used diversity types are listed. To see more options, click Show
More. The list of diversity types depends on the selected country.

Clicking on the Next button takes you to the Do you have diversity certificates? page where you can upload the
relevant document(s).

Tip: A verified diversity status ensures a higher ranking when customers look for new suppliers.
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After uploading a certificate, you can select the certifying agency (or add it if it is not in the list), enter the certificate ID,
indicate the issuance date and the (mandatory) expiration date, and provide a description.

Tip: You can upload multiple certificates for a diversity type.

Clicking on the Next button takes you to the Your commodities and area of service page where you can select the top
five UNSPSC categories you serve from the Commodities dropdown list. Indicate your Area of Service by selecting
the relevant radio button: Global or Regional. If you serve several regions, select the widest area that applies. You can
exclude up to five areas by entering them in the Exclusion Areas field.
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Clicking on the Next button takes you to the Almost ready to do business... page where you can provide your PO
email address (where you want your customers to send you purchase orders), DUNS number, and preferred currencies.
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Note: The DUNS number is secure information and is not published to your public profile.

Clicking on the Next button takes you to the Congratulations page informing you about your successful setup that
allows you to do business with your customer.
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You are encouraged to update your public profile so that other customers can also find you. Click on the Take Me
There button to open your public profile in edit mode. For more information, see Create or Update Your Profiles.

Note: Providing more profile information is optional.

Note: If your customer requested additional supplier information, you are informed that you are one step
away from doing business with your customer, and the Take Me There button directs you to your
customer profile in edit mode to respond to the supplier information form request.

Customer setup progress
You can exit any element of the flow any time by closing it with the x in the right corner above the Coupa logo, and you
can continue the flow to provide your information later.

On the Setup > Customer Setup page, you can see the list of all your customers and the status of your onboarding flow
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(setup progress) with each of them indicated by the green progress bar.

Select the customer name to see the relevant instructions and buttons to take the necessary actions.

• If you completed the onboarding flow, you can start transacting with your customer. You can go to the Admin page
for more setup options by clicking the Edit Your Setup button, or you can edit your public profile by clicking the
Edit Public Profile link.

• If you exited the flow before completing it, you can resume it with the Finish Setup button.

• If you have not provided information for your customer, you can Start the flow.

If you have not completed the flow for a customer, you are prompted to complete the customer setup when you log in
again.
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Enable or Disable Two-Factor Authentication
On the My Account page, click on the Security and Two-Factor Authentication link to enable or disable two-factor
authentication.

Note: Your customers can require you to use two-factor authentication to access their data in the CSP, in
which case you have to enable it.

Enable two-factor authentication

Note: If you want to receive SMS notifications or verification codes, you must enter and validate your phone
number under Mobile Phone Verification.

Under Two-Factor Authentication, click Enable for SMS or for Two Factor Authenticator App depending on how you
want to receive the verification codes.

• For SMS, enter the verification code in the pop-up window.
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After successful validation, you receive the verification codes in text messages.

• For installing and using Google Authenticator, follow the on-screen instructions.

CSP Admin and User Guide Get Started with the CSP

Valid until January 31, 2021 63



Choose Remember this computer for 30 day if you are not using a shared or public computer, and click Enable.

Print your backup codes or email them to yourself before you click OK. If you ever lose your device, you need these
to regain access to your CSP account.

Note: You can only use a recovery code once, so refresh your list if you have to use a recovery code.
Go to Account Settings > Security & Two-Factor Authentication and click Regenerate Recovery
Codes to get a new list of codes.

For more information, see Install Google Authenticator.

Disable two-factor authentication
Under Two-Factor Authentication, click Disable for SMS or for Two Factor Authenticator App and, in the appearing
window, enter your CSP password and click Disable Two-Factor Authentication.
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If you enable or disable two-factor authentication, you get an email notification of the change.

CSP Admin and User Guide Get Started with the CSP

Valid until January 31, 2021 65



Manage Your Account
On the My Account Settings page, you can make changes to your personal information (name, department, role, and
password), set or modify your notification preferences, or enable/disable two-factor authentication.

Note: You can access and edit you company information on the Profile page.

To change your account settings, click on your name link and on the Account Settings link.

Personal information
On the appearing My Account Settings page, fill in the fields you want to change, and then click Save. The asterisk (*)
indicates mandatory fields.
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Setting Description

User Details

*First name This is you personal first name.

*Last name This is your personal last name.

*Email This field cannot be changed. If you want to change it, you have to create a new
CSP account and connect it to your company. For more information, see Manage
Users.

Department The name of your department: Sales, Operations, Accounts
Receivable, Treasury, or Other.

Role Your role within the department:

• Sales: Sales Manager, Sales Associate, Other
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Setting Description

• Operations: E-Commerce Manager, Order Fulfillment/Inventory
Management, Other

• Accounts Receivable: Accounting Manager, Accounts Receivable Associate,
Other

• Treasury: Treasury Manager, Other
• Other: Enter free text.

Tip: If you select Other for Department and/or Role, the User Specified
Department and/or User Specified Role fields are displayed for you to
enter free text.

Change Password

*Current Password Your current password.

*Password Use this field to change your password. It must be at least 8 characters long and
it must include a number and a letter.

*Password Confirmation This field needs to match the password that you typed in the Password field.

Click on the Notification Preferences link to set or modify your notification preferences. For more information, see
View and Manage Notifications.

Click on the Security & Two-Factor Authentication link to enable/disable two-factor authentication. For more
information, see Enable or Disable Two-Factor Authentication.
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Navigate and Get Help
Help

Chat
Whether you are logged in to the CSP or not, you can chat with Coupa Support to get a quick response or resolution to
your case.

Note: This is not a chat option for communicating with your customers.

1. Click Chat with Coupa Support in the bottom right corner of the page to launch the chat.

Note: If all the support agents are offline or busy, you can Send a support request through an offline
form in the same chat window.

2. Provide your contact information: first name, last name, email address, and phone number (optional).

Tip: If you are logged in to the CSP, your contact information is pre-populated, but you can modify it.
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Note: If no support agent is available, you also need to provide the subject of your request and a
detailed issue description, after which you can see a confirmation that your case was submitted and
logged. A support agent contacts you as soon as they are available.

3. Start chatting with the support agent.
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If the support agent asks you to send a file, a paperclip icon appears on the left of the field where you type your
message.

Tip: After the chat ends, you can save the transcript.

Note: Your account and login information is not stored and support agents cannot log in to your CSP.
However, information provided in the chat is logged, so do not provide unnecessary personal information.

When you browse, the chat window persists on all the pages except for your Public Profile page, and you can minimize
it by clicking on the opposite arrows icon in the top left corner.

The chat is available also when accessing the CSP from a mobile device.

Help Tour and Online Help
When you log in for the first time, you are greeted by the Help Tour (welcome tour) on the Home screen.

Click on the Help link in the top right corner of the page to access the Online Help or to view the Help Tour any time.
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Main menu
To access a CSP function, click on the relevant tab on the main menu at the top of the CSP main page.

Menu Item Description

Home View and improve your public company profile, see the list of customers you are
connected to, edit your customer-specific company profile, and merge accounts.
You can go to the Home page from any page by clicking on the coupa supplier
portal logo/link in the top left corner above the main menu.

Profile Create, modify, and manage your public and customer-specific profiles, and
specify which remit-to addresses each customer can use.

Orders View the purchase orders you received from your customers.
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Menu Item Description

Service/Time Sheets View the list of service/time sheets and related purchase order lines.

ASN Send advance ship notice, that is, notifications about when you ship items to your
customers.

Invoices Create and manage invoices to send to your customers.

Catalogs Create and manage customer-specific catalogs.

Payments Accept payment through digital checks from your customers if they use
Coupa Pay.

Business Performance View a summary of orders and invoices that may need attention, your year-to-
date order and invoice trends, and your lead time to shipping goods.

Add-ons Access Coupa supplier add-ons, for example, Coupa Advantage, Coupa
Accelerate, supplier profile update, and more.

Admin Manage users, merge requests, and remit-to addresses, set up electronic
invoicing, add fiscal representatives, view and accept the Terms of Use, and set
preferred accelerated payment terms.
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View and Manage Notifications
Hover your cursor over the Notifications link to see your unread system notifications. Only the three most recent
notifications are shown.

To view all the notifications with their details and to manage them, click on the Notifications or the See All
Notifications link.

On the My Notifications page, you can view all your (read and unread) notifications, or you can filter by category (FYI,
Todo, Unread, or Announcements). You can select and delete them all or one-by-one.

Clicking on a notification link takes you to the relevant page.

To change your notification preferences, click on the Notification Preferences button in the top tight corner. Or click on
your name link and on the Notification Preferences link.
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You can access the notification preferences also from your Account Settings. For more information, see Manage Your
Account.

On the My Account Notification Preferences page, select the radio buttons for the items that you want to receive any
or all of the notification types: online (to do list), email, or SMS (short text message). You will start receiving notifications
when your customers enable them.

Note: You can choose to receive notifications in short text messages only if you have an SMS-capable
device and you validate your phone number. For more information, see Enable or Disable Two-Factor
Authentication.

SMS notifications are turned off by default.

If you turn SMS notifications on, but you disable mobile phone verification, your SMS notification selections are deleted.
You can also stop receiving SMS notifications if you reply STOP.

Setting Description

Announcements

New Customer Announcement Enabled by default: Online and Email

Note: You cannot disable online notifications for announcements.

Business Performance

Business Performance role
granted

Enabled by default: Online

Catalogs

A new comment is received Enabled by default: Online and Email

A catalog is approved Disabled by default.

A catalog is rejected Disabled by default.

A catalog is about to expire Disabled by default.

Coupa Accelerate

New Early Pay Customer Enabled by default: Online and Email

CSP Admin and User Guide Get Started with the CSP

Valid until January 31, 2021 75



Setting Description

Coupa Pay – Available only if your customer uses Coupa Pay and enabled the related features.

New digital check Enabled by default: Online and Email

New virtual card Enabled by default: Online and Email

Virtual card reissued Enabled by default: Online and Email

Virtual card reminder Enabled by default: Online and Email

Payment role given to user Enabled by default: Online and Email

Virtual card processing failure Enabled by default: Online and Email

Bank transfer remittance advice Enabled by default: Online and Email

Virtual card remittance advice Enabled by default: Online and Email

Zero payment remittance advice Enabled by default: Online and Email

Digital Check Cancelled Enabled by default: Online and Email

Virtual Card Cancelled Enabled by default: Online and Email

Early Payments – Available only if your customer enabled the feature.

Early payment request expired Enabled by default: Online and Email

Early payment request rejected Enabled by default: Online and Email

Early payment request matched Enabled by default: Online and Email

Early payment request paid Enabled by default: Online and Email

Form Responses

A form response is approved Enabled by default: Online and Email

A form response is rejected Enabled by default: Online and Email

Supplier information is updated Enabled by default: Online and Email

A new comment is received Notifies you if your customer sends you a new comment or a reply to your
question/comment regarding a Supplier Information Management (SIM) form
request/response.
Enabled by default: Online and Email

A form response needs your
attention

Enabled by default: Online and Email

Integration Errors

Enable notification for integration
error

Disabled by default.
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Setting Description

Invoices

A new comment is received Enabled by default: Online and Email

An invoice is approved Enabled by default: Online and Email

An invoice is paid Enabled by default: Online and Email

An invoice is disputed Enabled by default: Online and Email

An invoice is withdrawn from
dispute

Enabled by default: Online and Email

Legal Invoice Export Ready Enabled by default: Online and Email

An invoice is abandoned Enabled by default: Online and Email

Orders

A new comment is received Enabled by default: Online and Email

A new order is received Enabled by default: Online and Email

An order is canceled Enabled by default: Online and Email

Order Header Changes

Order change request is rejected Enabled by default: Online and Email

Profile

Public profile is updated Disabled by default.

An information update request is
received

Enabled by default: Online and Email

Profile update reminder is
received

Disabled by default. Future functionality.

Update information requests Disabled by default. Future functionality.

Receipt Request

Receipt created Disabled by default.

Terms of Use

New Terms of Use are received Enabled by default: Online and Email

Users

A new customer connection is
created

Enabled by default: Online and Email

Service/Time Sheets

CSP Admin and User Guide Get Started with the CSP

Valid until January 31, 2021 77



Setting Description

A Service/Time Sheet is
approved

Enabled by default: Online and Email

A Service/Time Sheet is rejected Enabled by default: Online and Email

You also receive notifications displayed in a green bar following certain actions, for example:

Note: If you change your notification preferences, remember to save them.
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Work with the CSP

This chapter contains the following topics:

View Business Performance Data
You can view a summary of orders and invoices that may need attention, your year-to-date order and invoice
trends, and your lead time to shipping goods.

View Customer Announcements
View announcements from your customers.

Configure Punchouts
Configure customer-specific punchouts by going to the Catalogs page and clicking on the Configure Punchout button.

Configure the PO Delivery Method
Select how you want to receive orders on the Orders page by configuring the PO delivery method.

Create or Edit an ASN
Notify your customer in advance of a shipment.

Create or Edit an Invoice
Work with existing invoices or create new invoices without a backing PO.

Create or Edit a Catalog
Create or edit a customer's catalog by going to the Catalogs page and by selecting the specific customer.

Create or Edit a Service/Time Sheet
Work with service/time sheets to provide information about your progress.

Create or Edit Catalog Items
Create or edit items in your customer-specific catalogs.

Edit a PO
Edit purchase orders and purchase order lines.

View and Download Digital Checks
Accept payment through digital checks from your customers if they use Coupa Pay.

View and Manage ASNs
View ASN information that you shared with your customers.

View and Manage Catalogs
View, edit, or delete your customer-specific catalogs.



View and Manage Invoices
View and edit invoices that you sent to your customers.

View and Manage Payments
View and manage overdue payments, early payment discount requests, tasks, and payment preferences.

View and Manage POs
View purchase orders received from your customers.

View and Manage Service/Time Sheets
View, edit, delete, or withdraw service/time sheets.

View Invoice Lines
View individual invoice lines by going to Invoices > Invoice Lines.

View PO Lines
View individual PO lines by going to Orders > Order Lines.

View Public Sourcing Events
You can access and participate in public sourcing events.

View Service/Time Sheet Lines
View individual service/time sheet lines by going to Service/Time Sheets > Service/Time Sheet Lines.



View Business Performance Data
Click on the Business Performance tab on the main menu to view a summary of orders and invoices that may need
attention, and year-to-date order, invoice, and delivery time trends.

Note: You can see this page only if you have the Business Performance permission. For more information,
see Manage Users.

View the order/invoice summary dashboards
In the top left corner, select from the list or search for the customer for which you want to see performance data.

The selected customer name appears at the top of the page and below it, you can see a summary (with numbers and
statuses) of your orders and invoices that need attention as follows:
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Document
Type

Status Description

Orders

Past Due For an issued order, if the "need by date" has passed and the order is not
complete.

Not Acknowledged The number of orders that you have not acknowledged. Shown only if you
acknowledged at least one order in the past.

Change Requested Orders for which you or your customer have requested a change.

Not Invoiced Orders that you have not invoiced yet.

Invoices

Pending Approval Invoices that have not been approved by your customer yet.

Unpaid Coupa Pay customer invoices that have not been paid yet.

Overdue Invoices that have not been paid yet and are past the due date.

Disputed Invoices that you or your customer have marked as disputed to indicate an
invoice discrepancy.

Tip: To see the description for a status, hover your cursor over the relevant number.

Clicking on the View links takes you to the Orders or Invoices page, respectively, showing only the list of orders/
invoices relevant to the status selected to view.

Note: The View links are visible only if you have permission to view orders/invoices.

View order/invoice/delivery time trends
Below the summary dashboards, you can find graphs for order, invoice, and delivery time trends for the past 12 months.

Note: The data provided is directional and for informational purposes only, and may be delayed up to one-
two weeks.

The order/invoice graphs show the volume/amount and count/number of your orders/invoices by month.
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Hover your cursor over Volume or Count in the legend to highlight the relevant data.

Hovering your cursor over the volume bar or count line shows you the volume or count of orders/invoices by month.
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Delivery time trends show the average delivery days (time in days between the order date and the receipt date) and the
number of orders delivered by month. Hover your cursor over the graph to see details.
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Cases when data or customer is missing

• If no data is available, for exmaple, there are no orders or invoices with the selected customer, the We could not
find any relevant (order/invoice) data message is displayed.

• If you have no transactions (orders or invoices) with a customer, the Before we can show you any cool stuff we
need you to get some orders and invoices in here! message is displayed.

• If you are not connected to any customers, the following message is displayed: You need to be connected to
your customer before we can show you any cool stuff. Ask your customer to send you an email invitation
from Coupa. This document explains the steps they need to take. It's super easy. The This document link
takes you to the page where you can learn how to add and connect with a customer in the CSP.

Learn more and provide feedback
In the top right corner below the list of customers, you can find the Learning Center and Feedback sections. Click on
the following links:

• Add a customer to learn how to add and connect with a customer in the CSP.

• Want to get paid earlier? to learn about payment options.

• Tell us what you think to provide feedback and suggestions to Coupa.

The Submit button is enabled only when you enter text in the Your message field. After submitting your message,
a green notification bar informs you about Feedback sent.
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Tip: You can also send an email directly to csp-bpm@coupa.com.
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View Customer Announcements
Your customers can create announcements to be shown to you on the Home page and/or other Coupa Supplier Portal
(CSP) pages to help you understand their unique onboarding requirements and communicate with you about initiatives,
promotions, and changes required for your collaboration through the CSP. With this one-way communication, your
customers can, for example, provide you with instructions on how to join or what to do after joining the CSP, share with
you information necessary for transactions, inform you about upcoming orders, remind you of updating supplier
information, and more.

You can see your customers' announcements at the top of the right section of the Home page.

Note: By default, only previews of the two most recent announcements are displayed. You can see the full
text of an announcement in a popup after clicking on it.

To view all the announcements with their full message, click on the View All (n) link that takes you to the My
Notifications page filtered by Announcements. For more information, see View and Manage Notifications.

The announcements are also shown where all the other notifications appear, that is, in the Notifications and My
Notifications sections.
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